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EXECUTIVE SUMMARY
Butte County meadowfoam (Limnanthes floccosa ssp. californica) is an annual plant that is
designated as endangered under the California Endangered Species Act and federal
Endangered Species Act. Butte County meadowfoam is only found in a narrow 28-mile strip
along the eastern Sacramento Valley in Butte County, and a population of Butte County
meadowfoam is located at the California Department of Fish and Wildlife (CDFW) North Table
Mountain Ecological Reserve (Reserve). Populations of Butte County meadowfoam have been
subject to historic grazing practices. Grazing took place at the Reserve for many years prior to it
becoming an ecological reserve, and CDFW has continued this practice to manage vegetation.
There is currently no evidence that grazing-related disturbances are presenting an ongoing
impact to the ability of Butte County meadowfoam to maintain a healthy self-sustaining
population at North Table Mountain Ecological Reserve, and therefore no change in
management is recommended at this time; however, CDFW should continue to evaluate
monitoring results at the end of each monitoring year.
Although there has only been one very limited estimation of residual dry matter on mima
mounds near the Butte County meadowfoam population in the fall of 2016, the October 2017
Cherokee Fire burned most of the Reserve and eliminated nearly all residual dry matter in the
vicinity of the Butte County meadowfoam population. The effects of the Cherokee Fire on the
Butte County meadowfoam population will be evaluated in the future.
The monitoring plan presented in this document was implemented from 2015 to 2017, and
implementation is expected to continue into 2021 or later. 498 Butte County meadowfoam
plants were found on the Reserve in 2017, 538 Butte County meadowfoam plants were found
on the Reserve in 2016 and 107 Butte County meadowfoam plants were found on the Reserve
in 2015, although the 2015 count does not include a group of plants that was not discovered
until 2016. The large populations of Butte County meadowfoam plants in 2016 and 2017 relative
to 2015 are likely due in some part to the high amount of rainfall in the growing seasons prior to
those years, particularly the rainfall in January and March of 2016 and 2017 relative to January
and March of 2015.
The monitoring plan should be implemented by CDFW staff at the Reserve to facilitate the
adaptive management of Butte County meadowfoam. The monitoring consists of three primary
parts: (1) a census of Butte County meadowfoam within monitoring plots; (2) monitoring
photographs; and (3) documentation of grazing.
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1. INTRODUCTION
Butte County meadowfoam (Limnanthes floccosa ssp. californica) is an annual plant that is
designated as endangered under the California Endangered Species Act and federal
Endangered Species Act. Butte County meadowfoam is only found in a narrow 28-mile strip
along the eastern Sacramento Valley in Butte County, and there is a small outlier population of
Butte County meadowfoam located at the California Department of Fish and Wildlife (CDFW)
North Table Mountain Ecological Reserve (Reserve) (Figure 1). Populations of Butte County
meadowfoam have been subject to historic grazing practices. Grazing took place at the Reserve
for many years prior to it becoming an ecological reserve in 1993, and CDFW has continued this
practice to manage vegetation.
This North Table Mountain Ecological Reserve Butte County Meadowfoam Monitoring Plan
(Monitoring Plan) should be implemented by CDFW staff at North Table Ecological Reserve in
Butte County. The purpose of this Monitoring Plan is to facilitate the adaptive management of
the populations of Butte County meadowfoam at the Reserve (Figure 2). The monitoring
consists of three parts:
1. A census of Butte County meadowfoam plants within monitoring plots;
2. Photomonitoring; and
3. Documentation of grazing.

2. ECOLOGICAL MODEL
See Figure 3 for an ecological model of Butte County meadowfoam.

2.1. LIFE HISTORY
Butte County meadowfoam is a winter annual that germinates in the fall after the onset of the
rainy season and begins to flower by mid to late February. Peak flowering typically occurs in
early to mid-March. Flowering in Butte County meadowfoam seems indeterminate (i.e.,
flowering continues until the necessary environmental conditions, such as moisture availability,
are no longer provided). Butte County meadowfoam plants can flower until early April when
rainfall is sufficient. Regardless of the rainfall, flowering does not typically continue beyond early
April. Fruit production is staggered throughout the latter part of the flower season into mid-April.
Butte County meadowfoam can develop mature seed and begin to die in May. Dead plants
disappear rapidly and are extremely difficult to find by late May or June. Butte County
meadowfoam persists as dormant seed in the soil from April or May until fall rains commence.
Water availability influences reproduction in the meadowfoam genus (Brown 1976, Brown and
Jain 1979). Insufficient moisture limits seed production in woolly meadowfoam (Limnanthes
floccosa ssp. floccosa) (Brown and Jain 1979) and is believed to have this effect on Butte
County meadowfoam (Jokerst 1988). Butte County meadowfoam regularly produces five seeds
per flower under ideal moisture conditions, but may produce fewer seeds under less ideal
conditions (Arroyo 1973).
Studies of meadowfoam seed dispersal suggest that dispersal is short-range, and seed is
distributed within vernal pools and swales (Jain 1976, Hauptli et al. 1978). Seed of rosy
Douglas' meadowfoam (Limnanthes douglasii ssp. rosea) was found to be dispersed in close
proximity to the mother plant, but some seed migrated up to 20 meters along ephemeral
drainages, presumably having been carried by flowing water (Jokerst 1988). Similar dispersal
3
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Figure 1
Regional Location of North Table Mountain Ecological Reserve
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Figure 3. Ecology of Butte County Meadowfoam (Limnanthes
floccosa ssp. californica)
 Seed bank likely larger than vegetative
population, seed dormancy possible
 In the closely related Limnanthes floccosa
ssp. floccosa approximately 67% of
individuals were in seed bank, and 50% of
those germinated each year
 No information on predation or disease
 Sets seed April, maybe into May
 0-5 nutlets per flower, 1.1 to 3.8 flowers
per plant
 Unusually limited natural seed dispersal,
by water
 Moisture stress reduces seed output

 Typically germinates with onset of fall
rains
 Does not persist in areas inundated for
prolonged periods, that remain wet in
summer or where water flows swiftly
 Seedlings often found growing near or
from underneath cobbles
 Moisture and temperature likely
promote germination

Seed Bank

Difficult to detect plants
that are not flowering

Seedling

Senescence
Reproductive
 Annual
 Plants senesce rapidly following reproduction
 Flowers can appear when there is still water in pools and as pools dry down
 Blooms in late February, March and into April
 Primarily self-pollinating, pollen gene flow likely limited

 Plants typically found near bottoms of
rocky vernal swales and sometimes in
vernal pools
 Reports of wide swings in population
size
 Excessive grazing noted to cause adverse
effects, but species has persisted in
areas with light to periodic heavy grazing
 Invasive plant species able to invade
rocky swales may compete for
light/water/space/nutrients

could be expected for Butte County meadowfoam because most populations occur along
ephemeral drainages and rocky swales.
Unlike some meadowfoam species, seed of Butte County meadowfoam is reported to germinate
easily when properly wetted in petri dishes, with up to 100 percent germination in laboratory
conditions (Jokerst 1988). Viable woolly meadowfoam seed, on the other hand, does not always
germinate under the same treatment. The timing and percentage of seed germination in the
meadowfoam genus is related to the length of exposure to water and patterns of temperature
change (Jain 1976; Toy and Willingham 1966, 1967). Wide fluctuations of Butte County
meadowfoam populations in the past, and populations that have been found in areas where
plants were previously absent indicates that Butte County meadowfoam has some dormancy
mechanism that activates the seed reserve during favorable conditions (Jokerst 1988).
Intensive livestock grazing likely has a significant negative effect on Butte County meadowfoam.
The predominant use of intensive livestock grazing for many years may have eliminated Butte
County meadowfoam from previously occupied suitable habitat in the past, and numbers of
Butte County meadowfoam have been reported to increase when grazing has been reduced
(Jokerst 1988). Butte County meadowfoam has persisted in areas that have received light to
periodic heavy grazing, so grazing is not necessarily detrimental to the persistence of Butte
County meadowfoam. Grazing may be beneficial for Butte County meadowfoam by preventing
or reducing thatch.

3. MANAGEMENT OBJECTIVES
Measuring above-ground expression of annual plant species such as Butte County
meadowfoam provides a quantitative annual record of the populations; however annual plant
species populations are known to fluctuate in response to environmental conditions. Therefore,
above-ground expression of Butte County meadowfoam may not be a good metric for making
short term management decisions. Because of this, a management objective and response for
adaptive management of Butte County meadowfoam will be based on population size/density
over several years.
The management objectives are:



Maintain at least 100 Limnanthes floccosa ssp. californica plants in North Table
Mountain Ecological Reserve Plots in at least two of the five years from 2018 to 2022.
Prevent grazing-related disturbances from impacting the ability of Butte County
meadowfoam to maintain healthy self-sustaining populations at North Table Mountain
Ecological Reserve.

4. MONITORING DESIGN
4.1. SPRING DENSITY MONITORING
The following sections provide instruction on how to implement this Monitoring Plan. As part of
the Monitoring Plan, the number of Butte County meadowfoam plants within specific plots will be
counted. Conduct the spring density monitoring when Butte County meadowfoam is evident and
easily identifiable, likely in March.

SAMPLING OBJECTIVE
We want to count all plants within the established monitoring plots.
7
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BEFORE G OING INTO THE FIELD
Before going into the field read this Monitoring Plan, recruit field helpers (a total of three or four
workers is ideal), and organize field equipment and datasheets.
Organize Field Equipment
(Figure 4):

i
f

l

n

d
a) (2+) 100 meter tapes
j
b) (2+) 50 meter tapes
m
c) Screwdrivers or other tools
c
for pinning meter tapes to
e
k
the ground
n
d) (many) Pin Flags
e) (4+) Hand tally counters
f) Data sheets, clipboards,
pencils (see Section 9)
b
a
g) Replacement plot
h
monuments (aluminum
g
conduit and/or rebar with
i
caps and lengths of pvc
pipe)
h) PVC pipe cutter
Figure 4: Spring Field Equipment
i) Tape measure
j) Small sledgehammer
k) GPS for relocating plot monuments and documenting plant locations
l) Tripod and camera
m) Compass
n) Zip-lock bags and/or plant press
o) Metal detector for relocating missing field monument locations (not pictured)

IN THE FIELD
Locate Macroplots
Contact the reserve manager prior to the visit (Henry Lomeli in 2017). Drive to and park at the
access location on Cherokee Road:




Latitude, Longitude: 39°34'55.06"N, 121°33'6.00"W
Google Maps: https://www.google.com/maps/@39.5819868,121.5517333,3a,60y,81.75h,65.72t/data=!3m6!1e1!3m4!1stmGW5VQSgJ7oe5bCmMXZA!2e0!7i13312!8i6656
See Figure 2

All plots can be reached on foot from the parking spot. Hop over or go through the fence on the
west side of the road. Plot B is 0.2 mile from the parking spot and the remaining plots are all in
the same vicinity (Figure 5). The plots were deliberately placed to encompass all Butte County
meadowfoam plants that were found at the Reserve in 2015 and 2016, but Butte county
meadowfoam plants do not occur throughout each plot. Each plots is marked with a rebar rod
with a red plastic cap that is hammered nearly all the way into the ground, and the plot
monuments are therefore difficult to relocate. The plot monuments are on mima mounds or in
areas that have higher microtopography than the areas occupied by Butte County
8
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meadowfoam. Vegetation on mima mounds tends to be taller that in the surrounding areas,
making relocation of plot monuments even more difficult. A GPS receiver is likely the best way
to relocate the plot monuments, and the coordinates of the monument plots are presented in
Table 1. In addition to the rebar plot monuments, two or four 8-inch magnetic nails were
hammered flush to the ground approximately 10 cm to the north, south, east and west of each
plot monument. These nails are backup markers. A metal detector may also be necessary to
relocate the plot monuments and backup markers. Some plot monuments may be missing due
to cows or vandalism. If any plot monuments are missing, use GPS, and a metal detector to
relocate and replace them.
Plot Name

Latitude and Longitude of Plot Monument

Plot A

39.5836282 -121.5554298

Plot B

39.5827791 -121.5552556

Plot C

39.5821869 -121.5559699

Plot D

39.5828036 -121.5561773

Plot E

39.5825990 -121.5559253

Plot F

39.5833333 -121.5552778

Table 1. Latitude and Longitude of Plot Monuments in Decimal Degrees
Once the plot monuments have been located, use meter tapes and a compass to delineate the
extent of the plots (see Figure 5).
Plot A is a 10 meter by 20 meter rectangle. The Plot A monument is in the center of the 20
meter west side of the Plot, and the plot extends 10 meters to the west (azimuth of 270°) of the
plot monument.
Plot B is a 10 meter by 35 meter rectangle. The Plot B monument is in the center of the 10
meter northeast side of the plot, and the rectangle extends 35 meters to the southwest (azimuth
of 230°) of the Plot B monument. When Plot B was first established in 2015, the plot only
extended 25 meters from the Plot monument, however additional plants were located outside of
Plot B in 2016, and therefore the Plot was extended to be 35 meters long.
Plot C is a circle with a radius of 30 meters. The Plot C monument is at the center of the circle.
Plot D is a 16 meter by 35 meter rectangle. The Plot D monument is in the center of the 16
meter northeast side of the plot, and the rectangle extends 35 meters to the southwest (azimuth
of 210°) of the Plot D monument. When Plot D was first established in 2015, the plot only
extended 25 meters from the Plot D monument, however additional plants were located outside
of Plot D in 2016, and therefore the Plot was extended to be 35 meters long.
Plot E is a 10 meter by 12 meter rectangle. The Plot E monument is in the center of the 10
meter south side of the plot, and the rectangle extends 12 meters to the north (azimuth of 0°) of
the plot E monument.

10
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Plot F is a 20 meter by 25 meter rectangle. The Plot F monument is in the center of the 20
meter south side of the plot, and the rectangle extends 25 meter to the north (azimuth of 0°) of
the plot F monument.
The extent of plots may be delineated in the field with meter tapes and/or pin flags.
Collect Data
With meter tapes strung out to delineate the extent of a plot, search the plot and surrounding
area for Butte County meadowfoam plants. Use pink pin flags to mark the locations of all plants
found. After all groups of Butte County meadowfoam plants within the plot have been found and
flagged, use a hand tally counter to count the total number of Butte County meadowfoam plants
within the plot. Counting may be difficult, particularly in areas with a high density of Butte County
meadowfoam plants. To keep counts accurate, first use additional meter tapes, or other
equipment to segment the population into smaller portions, and count the plants within those
smaller portions separately, and record them in field notebooks. The other field helpers should
conduct independent counts within the same areas, and all counts should be compared. If the
counts are inconsistent, the areas with inconsistent plant counts should be subdivided further
and recounted until the independent counts are the same.
The plots were deliberately sized and positioned to completely surround all Butte County
meadowfoam plants in 2015 and 2016, so it is unlikely that a Butte County meadowfoam plant
will be found right on the edge of a plot; however, should this occur, the plant should be counted
as being within the plot, and the area outside of the plot should be searched thoroughly for
additional plants. If any Butte County meadowfoam plants are found outside of the established
plots, one of the following two things should be done: (1) a new plot should be marked and
established encompassing the newly discovered plants or (2) an existing plot should be
expanded to include the additional plants, and the plants within the old plot boundaries should
be recorded separately from the plants within the expanded plot area. Use the following
counting rules:



If two flower stems are coming out of the ground from the same hole, but they cannot be
seen as being joined, they count as two different plants.
It is very difficult to detect plants that are not flowering; however, if a plant that is not
flowering is detected, it should be counted.

Record the number of Butte County meadowfoam plants counted in each plot on the datasheet,
and be sure to fill out all fields on the datasheet and take all other necessary field notes.
After counting all of the plants within the monitoring plots, search the area for additional
population of Butte County meadowfoam, and create new plots as necessary.
Complete a qualitative monitoring datasheet and take monitoring photos for each plot that data
was collected from before leaving the field site (see Section 4.2).

BACK IN THE OFFICE




Scan, save and re-name all field data sheets. The current project folder is:
U:\groups\HCPB\Shared Folders\NPP\Section 6\2014\Priority Plant Surveys\Project
Files\Butte County Limnanthes Files\Table Mountain. This project folder is likely to
change in the future.
Enter the field data into excel spreadsheets, perform quality control and analyze the
data.
11
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Compare the results with previous years and make graphs of the data. Make
conclusions. Think. Talk to the reserve manager about adaptive management of the site.
This is the most important part of adaptive management!
Download and rename field photos (see Section 4) and compare them with monitoring
photos from previous years.

4.2. ANNUAL PHOTOMONITORING FOR ADAPTIVE MANAGEMENT
Photomonitoring should be conducted for a plot whenever data is collected for that plot.

BEFORE G OING INTO THE FIELD
The monitor conducting the photomonitoring should be trained and familiar with the proper use
of a field compass and whatever digital camera and tripod will be used. The following equipment
is required:







Clipboard with photomonitoring log sheets (Section 9)
Pen or pencil
Digital camera with fully-charged batteries and available memory: a compact digital SLR
camera with a standard 18-55mm zoom lens is preferred for ease of photo comparison.
Tripod
Tape measure or meter tape
Compass set to the correct declination for the site (14 degrees east)

To duplicate approximately the same field of view from year to year, the camera should be set
to a focal length that is equivalent to a focal length of approximately 27mm on a “full frame”
camera such as a 35mm film camera or a Nikon “FX” camera and lens. Monitoring photographs
for the initial 2014 photomonitoring were taken using a Nikon “DX” camera and lens, set to a
focal length of 18mm, which is equivalent to 27 mm on a “full frame” camera and lens. Before
visiting the site, check the specifications for digital cameras that may be used for the monitoring
to see if photographs can be taken with the correct field of view. If the camera equipment to be
used cannot duplicate this field of view, the closest field of view possible should be used.

IN THE FIELD
All monitoring photographs are taken at or a specific distance from a plot monument. Refer to
the photomonitoring datasheet (Section 9) for the locations that monitoring photos should be
taken from. Once at the location of the monitoring photograph, do the following:






Set up the tripod and camera so that the center of the camera lens is 5 feet (152cm)
above the ground (the maximum height for many tripods), and directly above the
appropriate location on the ground.
Populate Each Page of the Photomonitoring Log with the date, photographer name,
focal length, camera, lens and camera settings, and any other relevant information.
Take a “Slate” Photo of the first page of the Photomonitoring Log sheet itself before
taking all of the monitoring photos on that page. Take a photo of the next page of the
Photomonitoring Log before taking all of the photos that are listed on that page, and so
on, until all monitoring photos have been taken.
Take monitoring photos in the order that they are listed on the photomonitoring
datasheet. Follow these rules:
o Use the field compass to ensure that all photos are taken in the direction
indicated in the Photomonitoring Log.
12
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o
o
o
o

Make sure that the camera’s zoom lens is set to the correct focal length (e.g. 18
mm on a Nikon d3100/d3300).
Set up the camera so that the horizon is 1/4 of the way down from the top of the
frame. Many cameras have a focus point at this location within the viewfinder.
Make sure the horizon in the viewfinder is as horizontal as possible.
Make sure that the camera focuses properly before taking the picture, and use
the preview function of the camera to make sure that the photo has been taken
correctly.

Center the horizon in the camera viewfinder at the location indicated with the red arrow

BACK IN THE OFFICE
Save all monitoring photos in the in a folder on the shared drive that corresponds with the date
of the field visit, for example: “U:\groups\HCPB\Shared Folders\NPP\Section 6\2014\Priority
Plant Surveys\Project Files\Butte County Limnanthes Files\Table Mountain\2017\040617”
Carefully change the names of the photo files using the following convention: [uppercase letter
of plot][lowercase letter of the photopoint][last two digits of year][two digit month][two digit day of
the month]. For example if a photo is taken at Photopoint m of Plot F, on March 12, 2015 the file
should be named “Fm20150312”.
All properly named monitoring photos should be saved in the following folder on the shared
drive: U:\groups\HCPB\Shared Folders\NPP\Section 6\2014\Priority Plant Surveys\Project
Files\Butte County Limnanthes Files\Table Mountain\Put all monitoring photos here for
comparison. The location of this folder may change in the future.
With the monitoring photos saved, use the Windows Photo Viewer program and the left and
right arrow keys on the keyboard to compare monitoring photos with those taken during
previous site visits and look for signs of excessive impacts from grazing and other differences. If
the monitoring photos are misaligned, it may be difficult to interpret the differences between
monitoring photos. It is possible to align the monitoring photos more precisely by carefully
manipulating them using Photoshop or other photo editing software. This is helpful for showing
precisely how specific areas of the ground (e.g. a gopher mound or group of cobbles) have
changed over the years. Guidelines for aligning monitoring photos using Photoshop CS6 is
provided as an appendix to this Monitoring Plan.
Think. Talk to the reserve manager about the management of the site. This is the most
important part of adaptive management!

4.3. DOCUMENTATION OF GRAZING
13
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At the end of each grazing period, the following information should be recorded and saved in the
project folder:





The actual number and size classes of domestic grazing animals present on the site.
The dates that animals were added to and removed from the Reserve, including the
dates that any animals were added late or removed early.
The dates of any efforts to herd animals to specific portions of the site, the locations
where animals were herded from and herded to, and the reason for herding them.
Any other information on grazing-related activities that took place.

5. RESPONSIBLE PARTIES
CDFW staff in the Native Plant Program or North Central Region (Region 2) should implement
this Monitoring Plan and report results and recommended actions annually to the Reserve
manager. The Reserve manager should make decisions on how to adaptively manage the
Reserve.

6. FUNDING
CDFW staff in the Native Plant Program used grant funding from the U.S. Fish and Wildlife
Service Cooperative Endangered Species Conservation Fund to prepare this Monitoring Plan
and collect monitoring data from 2015 to 2017. CDFW staff in the Native Plant Program are
expected to continue implementation of this Monitoring Plan from 2018 to 2021, funded by
another grant from the U.S. Fish and Wildlife Service. Continuation of this Monitoring Plan after
2021 is likely dependent on the ability of staff in the Native Plant Program to use staff time
funded by the endangered species tax check off fund, general fund, and other programs to do
so. Field helpers can often be borrowed from other CDFW programs if the appropriate program
managers approve the work as cross training for their staff. Implementation of this Monitoring
Plan could also be implemented by staff in CDFW’s North Central Region or by CDFW
volunteers. It is estimated that annual implementation of this Monitoring Plan will require the
following:
In-office preparations: 16 hours by one environmental scientist or senior environmental scientist
(specialist) = 16 hours
Field visit to check phenology: 8 hours by one environmental scientist or senior environmental
scientist (specialist) and one other field helper = 16 hours
Field visits to collect data and scout for additional populations: 16 hours by one environmental
scientist or senior environmental scientist (specialist) and two or three other field helpers = 56
hours
In-office data analysis and reporting: 24 hours by one environmental scientist or senior
environmental scientist (specialist) = 24 hours
TOTAL STAFF TIME NEEDED: Approximately 112 hours per year
Preparation of periodic summary reports and presentation of results may require additional time.
A summary report for 2015-2017 has been prepared, and another summary report will be
prepared in 2021 that will cover the period from 2015-2021.Prepare a summary report no less
frequently than every third year of monitoring.
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7. MANAGEMENT IMPLICATIONS OF POTENTIAL
RESULTS
Management Implication 1: If less than 100 Butte County meadowfoam plants are counted in
North Table Mountain Ecological Reserve Plots in 3 of the 5 years between 2018 and 2022,
collect seed from the population in 2022 for propagation and seed bulking by a qualified
institution, and return the seed to North Table Mountain Ecological Reserve in the spring of
2023.
Management Implication 2: If a qualitative assessment of photomonitoring and Butte County
meadowfoam density indicates that grazing-related disturbances are presenting an ongoing
impact to the ability of Butte County meadowfoam to maintain a healthy self-sustaining
population at North Table Mountain Ecological Reserve, the grazing intensity at North Table
Mountain Ecological Reserve shall be reduced by decreasing the number of grazing animals on
North Table Mountain Ecological Reserve in the following year, or during implementation of the
next grazing lease.
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9. DATA SHEET EXAMPLES
The following pages are examples of field data sheets that may be used or modified for
monitoring.
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North Table Mountain Ecological Reserve, Butte County CA
Limnanthes floccosa ssp. californica density monitoring
Date:
Notes:

Field Personnel:

Plot A (Marker at 39.5836282 -121.5554298)
Rectangular plot extending a length of 10 meters from the plot marker to an azimuth of 90°with
a width of 20 meters.
Counts:

Plot B (Marker at 39.5827791 -121.5552556)
Rectangular plot extending a length of 35 meters from the plot marker to an azimuth of 230°
with a width of 10 meters.
Counts:

Plot C (Marker at 39.5821869 -121.5559699)
Circular plot with a 30 meter radius from the plot marker.
Counts

Plot D (Marker at 39.5828036 -121.5561773)
Rectangular plot extending a length of 35 meters from the plot marker to an azimuth of 210°
with a width of 16 meters.
Counts:

Plot E (Marker at 39.5825990 -121.5559253)
Rectangular plot extending 12 meters from the plot marker to an azimuth of 0°, with a width of
30 meters.
Counts:

Plot F (Marker at 39° 35’ 00.16” -121° 33’ 18.76”)
Rectangular plot extending 25 meters from the plot marker to an azimuth of 0°, with a plot width
of 20 meters
Counts:

Photo Monitoring Points at North Table Mountain Ecological Reserve
Date:
Field Personnel:
Photos are from the markers for Limnanthes floccosa ssp. californica monitoring.

Photo a = From the Plot B marker take a ¼ horizon photo towards an azimuth of 225°.
Photo b = From three meters southwest (225°) of the Plot B marker, take a ¼ horizon shot
towards an azimuth of 225°.
Photo c = From three meters southwest (225°) of the Plot B marker take a picture angled down
approximately 45° towards an azimuth of 225°.
Photo d = From the Plot C marker take a ¼ horizon shot towards an azimuth of 0°.
Photo e = From the Plot C marker take a ¼ horizon shot towards an azimuth of 90°.
Photo f = From the Plot C marker take a ¼ horizon shot towards an azimuth of 180°.
Photo g = From the Plot C marker take a ¼ horizon shot towards an azimuth of 270°.
Photo h = From the Plot C marker take a ¼ horizon shot towards an azimuth of 315°.
Photo i = From the Plot D marker take a ¼ horizon shot towards an azimuth of 210°.
Photo j = From 6 meters in a direction of 210° from the Plot D marker take a ¼ horizon shot
towards an azimuth of 210°.
Photo k = From the Plot E marker take a ¼ horizon shot towards an azimuth of 0°.
Photo l = From the Plot A marker take a ¼ horizon shot towards an azimuth of 270°.
Photo m = From the Plot F marker take a ¼ horizon shot towards an azimuth of 0°.

California Department of Fish and Wildlife North Table Mountain Ecological Reserve Qualitative Monitoring
Date:
Field Personnel:
Location(s) Visited:

Describe the phonological condition of vegetation, soil saturation and soil disturbance

Describe any particularly abundant or notable plants or wildlife observed:

Describe Visible Threats and Disturbances:

Describe Weed Infestations:

Evidence of Livestock Use and Number of Grazing Animals Observed:

Photographs taken:

Recommendations:
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1. INTRODUCTION
This document summarizes the 2015-2017 monitoring results from implementation of the 2017
North Table Mountain Ecological Reserve Butte County Meadowfoam Monitoring Plan
(Monitoring Plan). The Monitoring Plan is included as Part 1 of this report and includes detailed
instructions on how to implement a monitoring protocol for Butte County meadowfoam
(Limnanthes floccosa ssp. californica) at the California Department of Fish and Wildlife (CDFW)
North Table Mountain Ecological Reserve (Reserve). The purpose of the Monitoring Plan is to
facilitatethe adaptive management of the populations of Butte County meadowfoam at the
Reserve.Implementation of the Monitoring Plan is expected to continue into 2021 or later. This
documentincludes an interpretation of results, an assessment of the monitoring project, and
managementrecommendations. The results and recommendations in this document are a
critical step in theadaptive management process.

2. SUMMARY OF RESULTS
This document reports on the result of the following monitoring components:
1. A census of Butte County meadowfoam plants within monitoring plots;
2. Photomonitoring; and
3. Documentation of grazing.
In addition, precipitation information generated using a PRISM climate model is presented, and
general observations of residual dry matter and other rare plants on the Reserve are reported.

2.1. SPRING DENSITY MONITORING
The locations of monitoring plots are presented in Figures 2 and 5 of the Monitoring Plan.
Populations of Butte County meadowfoam were observed and counted in monitoring plots every
year from 2015 to 2017 (Figure 1). Butte County meadowfoam was also observed prior to
implementation of the Monitoring Plan in Plot A in 2014, but a comprehensive count was not
conducted. Plots B and D were expanded in 2016 to include plants found outside of the Plots
that were not present when the Plots were first established in 2015. An additional group of Butte
County meadowfoam plants was discovered in 2016, and Plot F was established in 2016 to
monitor this group of plants.
498 Butte County meadowfoam plants were found on the Reserve in 2017, 538 Butte County
meadowfoam plants were found on the Reserve in 2016 and 107 Butte County meadowfoam
plants were found in 2015, although the 2015 count does not include plants that were likely
present within Plot F. The entire known population of Butte County meadowfoam at the Reserve
is within the six established plots (Plots A through F). Due to the size of the Reserve, Butte
County meadowfoam may occur elsewhere on the Reserve, but CDFW staff were unable to find
any additional populations during the course of limited-coverage annual surveys on the Reserve
between 2015 and 2017.

2.2. ANNUAL PHOTOMONITORING FOR ADAPTIVE MANAGEMENT
Thirteen Butte County meadowfoam photo monitoring positions were established at the Reserve
in 2015 and 2016, with monitoring photos taken in March or April after population counts were
completed. Monitoring photos were also taken on October 27, 2017 to document the aftermath
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of the Cherokee Fire, which burned most of the Reserve. Monitoring photos from 2015-2017 at
selected photo positions are presented in Figures 2 through 8.

2.3. DOCUMENTATION OF GRAZING
On December 14, 2017, CDFW Environmental Scientist Jeb Bjerke spoke with Mr. Todd York,
the livestock manager who has been managing grazing at the Reserve and the surrounding
private property for approximately 35 years. The surrounding private property is owned by a
mining company called Mineral Resources. Mr. York provided the following information on
grazing at North Table Mountain Ecological Reserve.
The Reserve and surrounding private property together comprise one pasture (grazing area).
Once cows are brought to the site, they are free to move about the entire grazing area. Grazing
is implemented adaptively, depending primarily on rainfall. When fully stocked, approximately
300-325 animal units are used in the grazing area (presumably all cow/calf pairs). Weaned
calves and light steers between 350-600 pound weight class are each counted as 0.7 animal
unit; and bulls, cows, cows with calves, and steers over 600 pounds are counted as 1.0 animal
unit.
Cows are typically first added to the grazing area sometime between November 1 and midNovember if there has been rain. Cows may be added earlier or later than this depending on the
amount of rainfall. Twenty to thirty cows may be added prior to November, even if there has not
been rain. During the grazing period, animals distribute through the grazing area well, but don’t
tend to go into the canyons, and prefer to stay on the table lands. Cows are removed near the
end of April to May 1. Water is typically still available later in the year after cows are removed
from the grazing area, and therefore some cows could stay in the grazing area year-round if the
livestock manager missed some animals at the end of the grazing period.
Mr. York said that there were approximately 60 cows in the grazing area at the time of the
phone call (December 14, 2017), and that less animals would be put in the grazing area for the
2017-2018 season than a typical grazing season because of the Cherokee Fire, which is
described below. Mr. York said that the production of grasses would be lower because grasses
are more productive in areas with some residual dry matter (RDM) left over from the previous
year. Because the Cherokee Fire eliminated much of the RDM from the grazing area, Mr. York
anticipated a less productive year. Mr. York said that there would likely not be significant
vegetation until mid-March, which would leave too narrow of a window to bring the full number
of cows to the grazing area and then remove them to be worth the effort. Mr. York said that he
was expecting the RDM to be higher at the end of the 2017-2018 growing season, which would
lead to higher productivity for the 2018-2019 growing season.

2.4. PRECIPITATION
Precipitation information generated using a PRISM climate model is presented in Figure 9
(PRISM 2017). Butte County meadowfoam germinates in the Fall after the onset of winter
precipitation and blooms in March and April; therefore, September to March precipitation is
assumed to be an important factor for Butte County meadowfoam growth and survival.
September to March rainfall was lowest in the 2014-2015 growing season, and highest in the
2016-2017 growing season. January and March of 2015 were very dry with little rainfall.
February of 2016 also had very little rainfall. It was very wet every month of the 2016-2017
growing season.
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2.5. OTHER OBSERVATIONS
In addition to Butte County meadowfoam, the rare plant Butte County golden clover (Trifolium
jokerstii) was also observed on the Reserve during the course of surveys for additional
populations of Butte County meadowfoam. Butte County golden clover has a California Rare
Plant Rank of 1B.2 and California Natural Diversity Database element occurrence numbers 2, 3,
6, and 10 occur on the Reserve. Portions of Butte County golden clover element occurrence
number 2 were observed by CDFW staff on March 16 and March 28, 2016, and a California
Natural Diversity Database field survey form was completed and submitted.
A cursory evaluation of the amount of RDM on mima mounds in the vicinity of the Butte County
meadowfoam population at the Reserve was conducted on October 20, 2016. The habitat in the
vicinity of the Butte County meadowfoam population is a mosaic of rocky pools and swales of
varying depths, veins of shallow volcanic rock outcrops, and shallow mima mounds of soil. The
Butte County meadowfoam population on the Reserve only grows in rocky pools of moderate
depth, and these pools were observed to be predominately occupied by native plants in the
spring, with very low RDM in the fall. This contrasts with the vegetation on the nearby mima
mounds, which have thick soil occupied by non-native grasses and forbs in the spring, with
higher RDM in the fall. This mosaic of habitat on the rocky tabletop landscape of the Reserve
exhibits drastically different RDM levels in different microhabitats. In an attempt to judge the
combined effect of the year’s rangeland production and grazing intensity, CDFW only clipped
RDM samples from mima mounds. We clipped RDM samples from one-square-foot areas on
three mima mounds adjacent to rocky pools supporting Butte County meadowfoam (one
square-foot area per mima mound). To be somewhat less biased in the placement of the
sampling locations, quadrats were thrown in the air and a one-square-foot area was sampled
where the quadrat landed. After each throw we subjectively judged whether the landing area
appeared to be representative of the RDM on the mound, but did not decide to re-throw any of
the samples. Vegetation within the quadrats was clipped as low as possible to the ground
without collecting soil or green plant material. The three samples represented RDM of 792, 712,
and 423 pounds per acre. The average of these samples is 642 pounds per acre of RDM on
mima mounds.

3. INTERPRETATION OF RESULTS
With only three years of monitoring data, it is difficult to make strong conclusions; however,
based on the spring population data collected thus far, the population of Butte County
meadowfoam on the Reserve appears to be relatively stable. Of the three monitoring years, the
Butte County meadowfoam population was largest in 2016, with the population similarly large in
2017, and smallest in 2015.
Rainfall in the months leading up to Butte County meadowfoam reproduction in March and April
are likely important factors influencing the population size for that year. The large populations of
Butte County meadowfoam plants in 2016 and 2017 relative to 2015 are likely due in some part
to the high amount of rainfall in the months prior to flowering. In particular, the January and
March rainfall in 2016 and 2017 was high relative to the January and March rainfall in 2015.
The monitoring photographs from 2015 show green annual vegetation over much of the
landscape except on very rocky outcrops. Monitoring photographs from 2016 and 2017 show
landscapes that appear marginally more densely vegetated and greener than the photographs
from 2015, and this is particularly evident on very rocky outcrops. Rocky pools, including some
supporting Butte County meadowfoam do not have any standing water in photographs from
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2015 and 2017, but do have standing water in photographs from 2016. Monitoring photographs
from 2016 have the least amount of yellow goldfields (Lasthenia sp.) blooming on the
landscape; however, many of the photos from 2016 were taken on March 16, and photos taken
later on March 28, 2016 show a much higher amount of blooming goldfields on the landscape.
Although the amount of blooming goldfields on the landscape is often striking in the monitoring
photographs, it is likely primarily a factor of the stage of phenological development of the
goldfields in that year. Unless observations of blooming goldfields are compared at the peak
bloom time of each year, which is hard to predict, such observations are unlikely to be
particularly insightful for year to year comparisons.
Although there has only been one very limited estimation of RDM on mima mounds in the fall of
2016, the October 2017 Cherokee Fire burned most of the Reserve and eliminated nearly all
RDM in the vicinity of the Butte County meadowfoam population. The effects of the Cherokee
Fire on the Butte County meadowfoam population will be evaluated after population monitoring
is completed in 2018 and following years. Tractor lines were cut on the Reserve near the Butte
County meadowfoam population during the course of the Cherokee Fire (see Figure 5), but
fortunately these lines did not impact the population. The tractor lines will likely remain visible on
the landscape for decades.
It is difficult to make conclusions with only three years of monitoring data collected so far;
however, of the factors observed, the Butte County meadowfoam population on the Reserve
appears to be most positively influenced by precipitation levels of five or more inches in January
and March, and most negatively influenced by precipitation levels of less than 1 inch in January
and March.

4. ASSESSMENT OF THE MONITORING PROJECT
The monitoring project has been largely successful. Our methods have resulted in important
initial data. The monitoring data for Butte County meadowfoam is highly accurate because all
Butte County meadowfoam plants found on the Reserve are within monitoring plots, and all
plants within the monitoring plots were counted. Uncertainty in the data is therefore not
statistical, but a result of counting errors due to the difficulty of counting in areas with a high
number of overlapping Butte County meadowfoam plants. Additionally, there may be Butte
County meadowfoam that was not found by CDFW staff because the Reserve is large and not
all areas were searched. It is likely that at least some Butte County meadowfoam plants were
present in Plot F in 2015; however, plants were not discovered in that area until 2016.
Additionally, attempts to precisely align monitoring photos has been difficult. Precise alignment
of monitoring photos is important because it allows direct comparison of specific areas of the
ground in the photograph, and it may be difficult to determine which areas of the ground are the
same if two monitoring photos are even slightly misaligned. Differences in perspective resulting
from photographs taken with different cameras, from slightly different positions and in slightly
different directions can be very distracting, and may require careful correction with photo editing
software such as Photoshop before insightful comparisons become easily possible. Because
correcting the differences in perspective requires photo editing expertise and a significant time
commitment, every effort should be made to carefully align monitoring photos in the field.

5. MANAGEMENT RECOMMENDATIONS
The management objectives and management implications identified in the Monitoring Plan are
repeated below, with a discussion of whether the management implications should be triggered
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based on the monitoring results. Additional management recommendations for the project are
also included.

5.1. MANAGEMENT OBJECTIVE #1
Maintain at least 100 Limnanthes floccosa ssp. californica plants in North Table Mountain
Ecological Reserve Plots in at least two of the five years from 2018 to 2022.
Management Implication Identified in the Monitoring Plan: If less than 100 Butte County
meadowfoam plants are counted in North Table Mountain Ecological Reserve Plots in 3 of the 5
years between 2018 and 2022, collect seed from the population in 2022 for propagation and
seed bulking by a qualified institution and return the seed to North Table Mountain Ecological
Reserve in the spring of 2023.
Recommendation: The management objective does not begin until 2018; however, there have
been at least 100 Butte County meadowfoam plants on the Reserve every year since monitoring
began in 2015. No change in management is recommended at this time.

5.2. MANAGEMENT OBJECTIVE #2
Prevent grazing-related disturbances from impacting the ability of Butte County meadowfoam to
maintain healthy self-sustaining populations at North Table Mountain Ecological Reserve.
Management Implication Identified in the Monitoring Plan: If a qualitative assessment of
photomonitoring and Butte County meadowfoam density indicates that grazing-related
disturbances are presenting an ongoing impact to the ability of Butte County meadowfoam to
maintain a healthy self-sustaining population at North Table Mountain Ecological Reserve, the
grazing intensity at North Table Mountain Ecological Reserve shall be reduced by decreasing
the number of grazing animals on North Table Mountain Ecological Reserve in the following
year, or during implementation of the next grazing lease.
Recommendation: There is no evidence that grazing-related disturbances are presenting an
ongoing impact to the ability of Butte County meadowfoam to maintain a healthy self-sustaining
population at North Table Mountain Ecological Reserve. No change in management is
recommended at this time.

5.3. OTHER RECOMMENDATIONS




Secure permission to survey and monitor Butte County meadowfoam element
occurrence 50, located on private property less than 0.5 mile east of the monitoring
plots, on the east side of Cherokee Road.
Continue to search for additional populations of Butte County meadowfoam on the
Reserve.
Update the vegetation management agreement for the Reserve to require simple
reporting at the end of each grazing season.
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APPENDIX A

Workflow for Aligning Monitoring Photos in Photoshop
This procedure provides a rough outline of a technique for aligning monitoring photos taken from the
same location using Photoshop CS6.
1. Open Photoshop CS6
2. Under “File”, select “Scripts” > “Load Files into Stack”
3. Select “Browse” and select all monitoring photos you would like to align
a. Only check “Attempt to Automatically Align Source Images” if there are lots of
buildings or other visually distinct aspects to the image, and even then, this may not
work well. If the result does not look good, start over and uncheck this box.
4. Select “Image”, and “Canvas Size” and increase the vertical and horizontal canvas size by a few
inches.
5. Select the top layer in the layers window, select “Filter” and “Lens Correction…” For “Edge”
select “Edge Extension”. Select OK.
a. NOTE: For photos taken with an SLR camera (Nikon d3100/d3300) a lens profile is
available, and should be used. The Native Plant Program point and shoot Sony camera
does not have a lens profile, so skip the lens correction step for photos taken on the
Sony.
6. Use the eye button to make the top layer that was just corrected invisible, click on the next
layer down to select it, and repeat Step 5 for all remaining monitoring photos.
7. Make the top layer visible again and click it to select it in the layers window. Click and hold the
eyedropper icon in the tools window, and select the ruler tool in the submenu.
8. Click and hold on a specific feature on the horizon on the left side of the image, and drag a ruler
line to a specific feature on the horizon on the right side of the image. Click the “Straighten
Layer” button at the top of the window. Repeat steps 6 and 7 for the remaining layers so that
the horizon is straightened in the same way for all monitoring photos.
9. Select a reference photo with lots of landmarks and identifiable features, and move it down to
the bottom layer in the layers window. (This will be your Reference Photo)
10. Make all layers invisible in the layers window, except for the bottom two layers. Make the layer
above the bottom layer about 50 percent transparent by selecting it in the layers window, and
using the “Opacity” slider, so that you can see features from both images at the same time.
11. Use the “Move Tool” by pressing V on the keyboard, and dragging the top layer so that it
matches the bottom layer as best as possible. Getting the horizon to match as much as possible
is a good first step. Matching features in the foreground is more difficult. There are several
techniques that can be used to help with this:
a. Resizing the layer by holding the shift key (to maintain aspect ratio) and clicking and
dragging a corner of the layer. -> be sure that “Show Transform Controls” is checked.
b. “Edit” > “Transform” > “Warp” can be used to drag features to where they need to be.
If a rock or tree needs to be moved to line up with the same rock or tree underneath,
simply drag it and move it. You will likely need to go back to other areas of the photo to
stretch everything into the right place. Just work on the photo until you are happy with
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13.

14.

15.

16.
17.

18.
19.

20.

the result. (Important note: do not accept the changes and apply the transformation by
pressing the “enter” key until you are completely happy with the result. Every time you
accept a transformation, the act is destructive, and it permanently degrades the quality
of the image)
c. “Edit” > “Transform” > “Perspective” can also be used if a side of the image is skewed in
one way or the other. Grab the edge you want to move and move it. I have only used
this successfully a few times, typically if most to the telephone poles are leaning in one
direction, for instance.
d. Once you have begun transforming the layer, you cannot turn the layer on and off to
check your work anymore, and you should therefore use the “Opacity” slider to see
what is underneath and check your work.
When you have completed a layer, make it invisible with the eye button, and make the next
layer above visible, select it, and continue with Steps 8, 9 and 10 until you have edited all of the
layers.
Select “File” > “Save As” and save the photoshop file as the photopoint name in the appropriate
location on the U Drive, for example: U:\Groups\HCPB\Shared Folders\NPP\Section
6\2014\Priority Plant Surveys\Project Files\Butte County Limnanthes Files\Stone Ridge\All
renamed photos here for comparison\Aligned Photos\Aq
(You might need to make a new Aligned photos folder in renamed photos folder)
Make all layers visible and select all layers. Select “View” > “Show” > “Layer Edges” to give you
an idea of where all of the layers overlap. Select the Rectangular Marquee Tool from the toolbar
window (a dashed rectangle).
Draw a selection within the area that all (or most) of the layers overlap. -> The layer edges will
disappear once you start to draw your rectangle so be sure to get a good idea of where to draw
before you start.
After the photoshop file has been saved, crop the image down by selecting “Image” > “Crop”
Make only the top layer visible and select it. If there are any areas along the edges where you
can see the transparency underneath and want to fill it in with camouflage, select the area using
the magic wand tool from the toolbar. After selecting the transparency, select “Select” >
“Modify” > “Expand” and increase the selection by 5 pixels.
Next click “Edit” > “Fill…” and select “Content Aware” to fill the blank areas.
Next click “File” > “Save as”, change the file type to JPEG and save the file in the appropriate
photopoint folder on the U drive, with the filename corresponding with that photopoint and the
date the photo was taken.
Repeat steps 15, 16 and 17 for the remaining layers.

